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Introduction to HyperStudio 

Installation
Insert the HyperStudio 5 disk into your disk drive.  When this window appears, double-click “HyperStudio 5 Installer”.

This will also automatically install both the HyperStudio 5 Web Plug-in for Safari, and the HyperStudio Player.  
Note:  If you wish to run stacks using HyperLogo that were created with HyperStudio 3 (or 4), you will need the HyperStudio Legacy 
Player, which can be found on the hyperstudio.com website.  HyperStudio 5 can open HyperStudio 3 or 4 stacks directly, where they can 
be run and edited, but you won’t get the HyperLogo component.
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Getting to Know HyperStudio 5
Once you’ve installed the program, click on the icon in the dock, or launch HyperStudio as you would any application.
The first screen that appears is the HyperStudio “Home Stack”.  A “stack” is the term used for a HyperStudio project file, and the 
word is related to the idea of a stack of note cards. So in HyperStudio, each screen is called a “card”, and the entire collection of cards 
(screens) that is saved in a file is called a “stack”.
You’re probably accustomed to applications opening with a blank screen, but in the case of HyperStudio, it opens with this pre-made 
HyperStudio file as a way of welcoming you to the HyperStudio environment.  This Home Stack has answers to likely questions that a 
first-time user might have, such as, “What is HyperStudio?”, and “Can you show me some examples?”
You can use the Preferences setting in HyperStudio to start with a Home Stack that you make yourself, to open the last stack file that you 
most recently had opened, or with just a blank screen.  
You can explore the Home Stack later, so for now, here is a brief review of the vocabulary and concepts behind HyperStudio.

The HyperStudio “Big Picture”
In a moment, you’ll be introduced to the various key parts of a HyperStudio project.  To summarize what is about to be introduced, here 
is a typical screen from a HyperStudio project as it is being worked on:

Learning to use HyperStudio is as easy as understanding what is shown on this single screen.

Cards and Stacks
An individual screen in a HyperStudio project is called a “card”, sort of like a 3” x 5” note card.  HyperStudio cards can be any size 
though, and common formats are based on the idea that the project may be exported to video for a podcast, posted on YouTube™ or 
School Tube, etc.
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However, any card dimension is possible, and other sizes are useful when, for example, one is anticipating printing the project to paper, 
such as for a small booklet of some type.  Although HyperStudio’s abilities with sound, animation and movies may seem counter-
intuitive to paper output, many people find the graphics manipulation abilities of HyperStudio so easy to use that they use just that part of 
the program for many graphics or graphics-plus-text projects, such as graphic novel (comics) style projects.
A HyperStudio project can have many cards, and the entire file is called a “stack”, as in a stack of cards.

Browsing and Editing
When a stack is open to any card in a stack, there are two modes that you can be in:

Browse mode• : This is the “normal” viewing mode for a stack, and you use this to navigate through a stack, clicking on buttons or 
other objects to move to other cards, play sounds, etc.  This is the mode that another person viewing or using your stack would be in if 
they were operating your stack using the HyperStudio Player, or if your stack were posted as part of a web-page.
Edit mode• : The cursor changes to the edit cursor (arrow), and you can move items around, delete them, and to set up or change 
anything about that item.
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             Browse Mode     Edit Mode

Note: Part of the design philosophy of HyperStudio is to have as little difference between how a stack looks while you are editing it, and 
how it looks when it is being viewed and navigated by others.  Another part is the principle is that HyperStudio stays out of your way as 
much as possible, appearing only as necessary to assist you in the changes and additions (or deletions) that you wish to make.

Background and Objects
A card has two basic parts:  the background, which is painted with the paint tools and/or brought in as image or photograph which can 
then be further edited,

and a few types of objects which are placed over that background, rather like actors on a stage in front of a backdrop. 
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Graphics, Text and Movie objects are the basic actors, and Buttons are the directors.  Clicking on a button makes something happen.

Painting on the Background
Painting on the background is done with the tools in the Tools palette.  The tools palette is found in the Window menu:

   which will then open or close the Tools Palette:

Tools Options

->

where double-clicking on most tools will open a drop-down drawer with specific options for that particular tool.  (the only exceptions are 
the square and oval selector tools).
There is a slider near the top of the Tools palette, which can be changed between “Background” and “Objects”.  When the slider is on 
“Background”, you are painting and working in the background of your card.  To erase something you will need to either paint over it 
with another color, use the eraser set to some color such as white, or use the dotted line selector tool to surround an area, followed by 
pressing Delete.  (Cut, copy & paste work as well).
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Painting as Objects
When the slider is in the “Objects” position, the paint brush strokes are each objects that float in front of the background.  This also 
applies to the “T” (for Text) tool.

VERY IMPORTANT: If you want to create text that you can edit later, and which is not part of the background, either use Add a 
Text Object from the Objects menu, or make sure that the Tools Palette slider is set to “Objects”.  If you use the “T” tool with the 
slider set to “Background”, remember that you are “painting” text, and to erase or move it later you will have to use the paint tools.  
Painted text cannot be “edited” later to correct typing errors in the way that you can for Text Objects.

Actions and Appearances
Buttons make something happen when someone clicks on them, and what a button (or other object) looks like, and what it does is set up 
using what is called the “Inspector”. 

The Inspector is shown above, and is opened by either double-clicking on an object with the edit tool (if the Inspector is not already 
open), or choosing “Show Inspector” in the Window menu.

Note: Double-clicking a Text Object goes directly to editing the text within the Text Object, and as such brings up the Inspector for 
the text that you are entering, not the object itself.  To see the settings for the Text Object itself, open the Inspector first (from the 
Window menu) and then click just once on a Text Object.  This particular bit of the “flow” may take you a few times to get the hang 
of it. (Check that the “Use a double click to modify content in Edit mode” option is selected in the General pane of HyperStudio 
Preferences - if it isn’t, use Option-click to start editing or entering text in the text object).

Once the Inspector is opened for a button (or other object), there are four “tabs” across the top for setting different attributes of the object 
that is currently selected. In the Actions pane you can assign actions to the object. The actions are offered in two lists titled “Places to 
Go” and “Things to Do”:
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Places to Go in the most common form takes the viewer of the project to another card in the stack.  However, it can also open a document 
in another application.
Things to Do allows you to select actions such as playing a sound, starting a movie, making objects appear or disappear, and also 
includes directing a web-browser to open a particular web-page.  “More Button Actions” leads to a further list with even more actions 
that can be activated by clicking on a button.
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Invisible Buttons
In all the illustrations shown so far, the buttons were clearly visible as a simple button.  However, in many projects, buttons are set up as 
invisible buttons. That is, they define a region on the card where, if someone clicks the mouse there, the button action is activated.
How a button looks is set up using the first tab in the Inspector, which is labeled  “Appearance”.

Choosing the different button styles changes the appearance of the button.  Note that there is a lasso, a free-hand pencil, and even a 
special “expanding lasso” that can be used to define the region for an invisible button.

How do I Know When I’m “Done”?
Because HyperStudio is designed to be VERY free-flowing in its use, in general, you’re not “done” doing something; you merely reach 
a point where your attention shifts to something else that has come to mind as the next thing that you wish to work on, and off you go to 
work on that.  Later, perhaps you think of something that you want to add to the first thing that you were working on, and go back to it, 
even if just for a moment.
And so it flows, hopefully with your ideas and actions smoothly moving from one thought to the next, and HyperStudio being there to 
help materialize what is in your imagination, but not getting in the way of it.

Changing Back to the Browse Mode
When you do want to test a button, remember to change back to the Browse mode from the Edit mode.  A shortcut for going between the 
two modes is Ctrl-TAB, which you will find very handy as you use the program.

Moving Between Cards
The easiest way to move between cards is to use Cmd-< (Command-comma) and Cmd-> (command-period) to move to the previous and 
next cards.  There are also a number of items in the Go menu that will take you to other cards in a stack.  This works in either the Browse 
Mode or the Edit Mode.  
In fact, almost everything works the same in both Edit and Browse Modes. The main difference between the two is as simple as “In the 
Edit Mode, if you put the mouse on a button or other object, it selects it.  In the Browse Mode, it triggers an action.”
At all other time using HyperStudio, it doesn’t much matter which mode you are in. For example, if you are in the Browse Mode, and 
choose Add a Graphic Object, HyperStudio will happily change to the Edit Mode and go about adding the graphic that you wish.

Putting it all Together
So now, that screen at the beginning of this introduction should seem simple, and be understandable:
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Each screen is called a card, which collectively makes up a stack. On each card is a background, which has four types of objects on it 
(Button, Graphic, Text and Movie Objects).  Any of those objects can be set up for various actions using the Inspector.
In general, once you’ve learned how something looks and works in one part of HyperStudio, you’ll find similar screens and processes in 
the other expected places as well.
We call this the “DNA principle” of HyperStudio.  HyperStudio has a very simple base layer to it:  A paint program in which you can put 
five things on every card:  buttons, graphic objects, text objects, sounds and movies.  Buttons trigger other actions such as going to other 
cards, playing an animation, opening  a web-page, etc.
Once someone has that understood, it’s like DNA (or LEGO). DNA has four nucleotides that can be represented with four letters: A, C, T 
and G. Those four can be combined to make both a tiger and a daisy, a bacteria or a sequoia.  How is it that so many things can come out 
of just four “letters”? But that is in fact the source of the power of it all. With HyperStudio, you can quickly see and understand the four 
basic objects, each of which can have a variety of actions, and from that build a truly unlimited range of projects.

Views
Another menu that will be handy to know about is the View menu.
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The first entry, “Enter Edit Mode” (or Enter Browse Mode) is the same as choosing the hand or the arrow in the Tools Palette.
The next four entries offer different ways of viewing your project.  Normally, you are in a “standard” or “design” view, where you shift 
between edit and browse as you develop your project.
However, there is also a Presentation view, where your stack will be displayed filling the display screen area, and without the menu bar. 
(Move the mouse cursor to the top of the display area to show the menu bar, or press Escape to leave the Presentation view).
Player view is used to preview how your stack will appear if you send it to someone as a self-contained “Stack to Go”, or if someone that 
doesn’t have the full HyperStudio application is viewing your stack with the HyperStudio Player, which is available to anyone free of 
charge on the hyperstudio.com website.
Storyboard view shows all the cards in your stack in one window, and is handy for re-ordering the cards.  It also allows you to drag 
a graphic image from the desktop or another application onto the storyboard to quickly make a new card with this image as the 
background.
Slide Show view plays a stack as a simple slide show of images.  It is played with all animations, sounds, and actions, including those 
triggered by the automatic timer or assigned to arriving at and leaving cards.  Slide Show view is also useful when you drag a folder of 
images to the HyperStudio application icon — the images will instantly be made into a stack, and you can choose Slide Show to rotate 
through them.

What’s Next?
This concludes this very brief introduction to HyperStudio, which is intended to quickly give you enough context and sense of the 
HyperStudio environment to start exploring.
This is obviously just the beginning though, and there is much more than can be learned about the HyperStudio program, and how use it.  
Like DNA and LEGO, with these simple building blocks, you can not only do digital storytelling, but create everything from animated 
videos to projects on paper(!).
There are many books that have been written about previous versions of HyperStudio, and Professional Development workshops are 
already being planned in many places worldwide.  However, it’s also true that part of the fun of HyperStudio is sharing your own 
discoveries about ways of using it with others, and I encourage you to do just that.  The first HyperStudio video tutorials are starting to 
appear on YouTube and Teacher Tube.  That is, as they say, just the tip of the iceberg, and you will no doubt think of your own ways and 
places to share what you are best at, and that HyperStudio helps you do more effectively.
The documentation for HyperStudio includes a simple Tutorial that will take you through the building of a simple stack.  There is also a 
HyperStudio Reference, which has information on the HyperStudio application in detail.

Keyboard Shortcuts
In general, most common operations in HyperStudio can be done with a keyboard shortcut instead of manually choosing something from 
a menu.  
For example, Cmd-C works to copy a selection in place of choosing Copy from the Edit menu.  For HyperStudio-specific functions, the 
Option key is used.  For example, for “Add a Graphic Object” you can press Option-G.   
Some shortcuts use a combination of the Option and Command keys, such as Option-Cmd-T to show the upper icon shortcuts toolbar, or 
Shift-Option-O to “Merge Selected Objects”.  
For those who have used prior versions of HyperStudio under Mac OS 9, there is a change here where HyperStudio 5 now uses the 
Option key as the primary modifier compared to HyperStudio 3, which used the Cmd key.  For example, HyperStudio 3 used Cmd-G to 
add a Graphic Object, and HyperStudio 5 uses Option-G.
It’s also worth mentioning one very special pair of keyboard shortcuts: Option-Cmd-C (copy text style), and Option-Command-V (paste 
text style). This is a very handy way to copy the font style, size, etc. from one portion of text to another, without having to look up the 
font style, etc.  Try it – you’ll love it! 
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Using the Inspector
The Inspector is the floating window that tells you about any selected object.  There is also an Inspector for the stack itself, and the 
Inspector can be used to set up actions for any particular card.
If you have coaching hints turned on in the HyperStudio Preferences, the Inspector window is also where these coaching hints will 
appear when you are doing some particular editing activity such as adding a new button or graphic object.
The following sections show the typical Inspector windows for the most common objects in HyperStudio, along with the Inspector 
window for “About This Stack” and “About This Card”.
To see the Inspector for a given object you can either:

Double-click on the object, or,• 
Choose “Show Inspector” from the Window menu.• 

Note: Double-clicking on a text object goes directly to entering text for that text object, and the Inspector window that opens will be for 
the particular text that you are typing, not the text object itself.   This is to make it easier to edit text objects (the double-clicking to edit 
feature), but it makes it a little tricky to get to the Inspector for a text object if the Inspector window is not already open.
For that reason with text objects in particular, you may find it easier to remember the “Open the Inspector” keyboard shortcut, so that you 
can click once on a text object, and then press Option-I (for “Inspector”) to open the Inspector at those times when it’s not already open.

Inspector Screens Summary for Objects
Here is a visual summary of the different Inspector windows that you can expect to see while working with the different objects in 
HyperStudio, and also the “About This Card” and “About This Stack” Inspector screens.
It is very much worthwhile for you to review these screens so that that you’ll know what options are available to you.

Button Object
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Graphic Object

   

   

Text Object
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Movie Object

   

   

Animation Options
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Sounds (attached to the background, or as a button action)
Sounds are a little different, in that they are not “objects” that you can see in the Edit mode, or select with the pointer tool.
Sounds are always attached to an object, unless you want the sound to play when the user arrives at a card, leaves a card, or clicks on a 
card.
In that case, they are attached to the card itself, and you access the sound settings by choosing “About This Card” from the Background 
menu, or, by double-clicking on the card with the Edit tool (the pointer).
Normally though, sounds are attached to a button or other object using the Play a Sound action (“Things to Do”), and the Inspector 
screens for Play a Sound look like this:

“Background sound” means that the sound will keep playing even if other sounds start.  When a sound is not marked “Background”, it 
will stop if another sound starts playing.

About This Card (in the Background Menu)

   
This Inspector window is used most often for accessing a sound or movie that has been attached to a card, set up for “clicking on card...” 
so that whenever a user clicks on a card, they hear the attached sound.
It is also used by the “Make Every Card Next Card” Extra, which uses the same “clicking on card...” option to make every card do a “go 
to next card” action when a user clicks on any of the cards in a stack.
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About This Stack (in the Background Menu)

   
This is similar to “About This Card”, but this is for setting up actions for the entire stack itself. So, for example, if you wanted speech 
recognition to be active whenever a stack was loaded, regardless of which card was “arrived at” from another stack (remember, you don’t 
have to always enter a stack on the first card), you could set up “Arriving at stack” to turn on speech recognition.
This window also shows you the size of your stack in pixels, and options for setting up actions that will happen each time the stack is 
opened or closed, or if the user clicks anywhere on any card where there isn’t already a button or other object that is receiving the mouse-
click.
If you choose to change the size of your stack, here are the windows that you will see:

   
When choosing stack sizes, keep in mind how you might wish to share or publish the stack.  Most of the sizes suggested here have 
different video export formats in mind, such as for YouTube or podcasts.  However, you can also make stacks that are designed to be 
posted on VideoThread, or even printed to paper, such as a comic book style project.
We also encourage you to “think outside the card”, for example, using a comic book style “look” to a project that will be exported as a 
video!
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List of “More Button Actions” and Their Functions

AutoRecord: Records a sound from the user while browsing a stack and writes it to a sound file.

   

BlabberMouth II: Speaks specified text or text within a text object using speech synthesis.

   

Button Lister: This action highlights the buttons you list and activates them after a predefined delay. When Button Lister is active, the 
user can click or press the space bar or the 1 key to move the highlighting to the next button in the list. Pressing the 2 key moves the 
highlighting to the previous button in the list. Adaptive switches can be used together with a device that can emulate a mouse click or the 
number keys 0–3. 
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Button Scanner: Used for assistive technology support for special needs users, this starts the automatic “scanning” of all the buttons on 
a card, “highlighting” each one for a given amount of time before moving on to the next button.  The user “clicks” a button by means of 
any single-action switch device, such as the “Switch Click” or “Mini Click”, manufactured by RJ Cooper Associates.

   

Button Stepper: Button Stepper makes HyperStudio highlight buttons in response to presses of the space bar and the 1 and 2 keys. 
When Button Stepper is active, pressing the space bar or the 1 key highlights the buttons in the listed order. The 2 key highlights the 
buttons in reverse order. When the user clicks with the mouse, the currently highlighted button will be activated. Adaptive switches can 
be used together with a device that can emulate a mouse click or the number keys 0 - 3. 

   

ClearChangeFlag: Usually, if you make a change to a stack, it sets a “change flag”, which prompts the user with the question, “Do you 
wish to save changes to this document?” when you leave the stack, or quit the HyperStudio application.  There are times where a user 
of the stack may have made changes, such as moving draggable graphics, entering text, or using the paint tools, and where the stack 
designer wishes to “clear the change flag” so that the “Save Changes?” window does not appear.
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GhostWriter: This makes text “magically appear” in a text box as though it were being automatically typed (which it is).   The speed at 
which the “typing” occurs can be changed while the text is appearing.

   

HideCursor:  Use this if you wish the cursor to disappear on a card and not be visible.  The cursor can either be hidden until the mouse 
is moved, or hidden totally until another button (or other object) action makes it visible again. If you were making a stack that was a 
presentation designed to be operated with a remote control “clicker”, you could use this with a “About This Stack”, and then “clicking 
on stack” to hide the cursor (with the option of Hide until mouse is moved) to hide the cursor during your presentation unless you chose 
to deliberately use a mouse at some point.  If used as just described, the cursor will be hidden again when you click on any card in that 
stack.

   

I’m a Home Stack: HyperStudio has a special category of stack called a “Home Stack”. What makes a Home Stack unique is that the 
“Home” command in the Go menu, or as a button action, loads (goes to) whatever stack is currently is set as the Home Stack.  Normally, 
this would be the Home Stack in the HyperStudio application (which is itself actually a folder that contains the usual Home Stack).  In 
addition when going to a Home Stack with the Home command , HyperStudio returns to the last card viewed in that stack.  This means 
that without any special individual configuration of buttons, all the stacks “visited” by a “master Home Stack” automatically return to 
whatever card they were “launched” from when the “Go to Home Stack” action is encountered.
If you use this “I’m a Home Stack” MBA (More Button Actions) function, you can make any stack the “Home Stack”, and then any stack 
with the “Go to Home Stack” action will return to the exact card last viewed (in the current session of running HyperStudio).
So, imagine the following:  You are a teacher or presenter with a master “menu” stack of several cards, perhaps titled “History”, “Art”, 
and “Science”.  On each of those cards is found 3 buttons (or more nicely, graphic objects with actions) which go to 3 separate example 
stacks for that topic.  So that’s 3 cards, each of which go to 3 stacks, for a total of nine examples.
Now for each of the nine example stacks to return to the appropriate card of the menu stack, you might think that you would have to 
make a button, perhaps called “menu” that would use “connect to another stack”, and then the particular topic card (history, art, or 
science) that had opened the stack.  But then what happens if you want to show those same examples from a different “menu stack” 
entirely? You would have to re-edit the “return to menu card” button in all the stacks.
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However, if you simply use the MBA function “I’m a Home Stack” in the Menu Stack, and then in every example or sub-topic stack that 
you create, have “return to menu card” set up as “Home Stack” under the “Places to Go” column, any of the stacks when run will return 
to whatever the last “menu stack” stack, AND on the exact card of that menu stack, that the user (or you as a presenter) was last viewing.
Many times professional presenters have hundreds of potential sub-topics that they “mix and match” for any particular presentation.  In 
traditional presentation software, the resequencing of these sub-topics can be tedious, requiring that the presenter either (a) copy and 
paste the sub-topics into a new single file, or (b) connect the last screen of each sub-topic to the first screen of the next sub-topic.  If there 
are 20 sub-topics, this requires 20 edits to 20 files, assuming that each sub-topic is its own file.
With HyperStudio, and the I’m a Home Stack function, there is an incredibly elegant alternative:
Each of the sub-topics has “Go to Home Stack” as the last card, and optionally, you can put a small icon on each card to exit the sub-
topic on any card.
Now create your main presentation stack as a “concept map” with individual graphic objects made from the card image of the first card 
in each of the sub-topics. Each of those graphic objects has its “Actions” set up (as though it was a button) as a link to the sub-topic 
stack, and the main stack itself has “I’m a Home Stack” set up as an “arriving at stack” (found in About This Stack under the Background 
menu).
That’s it!  The main presentation goes to each of the sub-topics by clicking on one of the graphic objects, and clicking on the last card 
(or the “Go to Home Stack” button) in each of the sub-topics returns to the main presentation on exactly the card that the sub-topic was 
launched from.
Now, hang on to your seat: When it’s time to make a new presentation with a new mix of sub-topics, you merely copy and paste the 
graphic objects from one main presentation file to your new one.  The stack connections are already in the graphic objects, and they will 
all still connect to each of the sub-topic stacks.  
Another variation is to make a “master topic card”, or cards, which contain all the potential sub-topic graphic object “buttons”, and then 
to make a new presentation, you delete the sub-topics that you don’t want, and arrange what’s left however you wish.
So, having said all that, here is the actual Inspector screen for I’m a Home Stack. It’s very simple, but oh-so-very powerful! 
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KeyMapper: This lets you assign a specific key that will be treated the same as if the user had clicked on the button. Because this can 
set up the key assignments for many buttons, it is not used as the “Action” for the button that will respond to the keypress, but rather 
KeyMapper is often used with “About This Card” or “About This Stack”, and “arriving at card”, or “arriving at stack”.  KeyMapper stays 
active for the defined keys until the stack is closed or a different button or other object redefines that a particular key is assigned to a new 
button or object.

   

Movie Controller: This is used to control a movie by activating an object. 

   

Open Stack: This is used to open an existing stack or create a new one.  
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Pause: This is used to delay the execution of actions assigned to an object.

   

PictureShow: This is used to display a simple slide show of pictures located in a specified folder.

   

PrintCard: This lets you initiate the printing of a given card with a button on that card.  This can be used for stacks that let users enter 
text or paint on the card, or cards with information that you wish to offer the user an option of printing out, such as in a kiosk.
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Quit: This causes the HyperStudio application to quit.

   

Quit Another: If you were to use the “Places to Go” action, and “Another program”, it would be useful to be able to also close that 
application when you wanted.  Quit Another will do just that: close the specified application. 

   

RollCredits:  This will automatically scroll the contents of a text object, even if it is a rotatable text object!  If combined with 
TextMover, you can move the contents of “Comments and Attributions” from each card in a stack into a “Credits” text object at the end 
of your stack, and then use RollCredits to make them roll up the screen.
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RunAppleScript: This lets you enter any AppleScript text, and the “program” will run when the button (or other object) is activated.  
Note: This only works on the Macintosh computer, and is not available under Windows.  Keep this in mind if your stack will be running 
on a webpage in a browser that may be running under Windows.

   

ScrollCard: Moves the point you specify into view on the screen.

   

Sequencer: Although HyperStudio does not yet have a scripting language implemented, the Sequencer can be a useful way of activating 
a series of buttons at particular moments.
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SetCursorPos:  This will position the cursor at a specified location on the card.  This is often used with adaptive software so that the 
cursor can be positioned over a given button (or object with an assigned action), and all the user needs to do is “click”, rather than do 
actual mouse movement and targeting.

   

SetVolume:  Sets the computer volume level.  Useful in making adaptive software applications so that the user can change the volume of 
synthesized speech or other sounds for their own particular comfort level.

   

Show in Finder: Shows the specified file in the Finder when you activate the object.
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ShowMessage: Displays a message box on the screen with whatever text you specify.

   

Slide Show: This is similar to the menu item “Slide Show” in View, but is activated by a button or other object action, and can be used to 
create slide shows of stacks when you want to quickly set up a series of pictures.

   

Fast slide show technique:  “Slide Shows to send and share”
Drop a folder of images on the HyperStudio icon in the dock.  HyperStudio will create a stack with a card for each image.  (Note that 
small images will be blurry when expanded, so use images of reasonable resolution).
Make a button on the first card that says, “See the pictures…”, and make the action for it, “Slide Show”.
Send the stack to a friend using “Export” in the File menu, and export as “Stack to Go”.  When they click on the stack, it will open 
without HyperStudio being required on their computer, and when they click on the button, they’ll get the slide show.  If you also attach 
music to the same button, you’ll have your sound track as well!
Another way of doing a slide show: “Extra: Make Every Card Next Card”
Drop a folder of images on the HyperStudio icon in the dock.  HyperStudio will create a stack with a card for each image.This 
automatically sets up “Go to next card” as the “Clicking on this Card” action for every card in the stack. 
Now, you can manually show the entire series of images by just clicking on each card. If you go to “About This Card” in the background 
menu on the first card, and then “clicking on card” and set up some music, you’ll have that music for the background music for the entire 
slide show as well.
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SpeechRecognition: This uses the Macintosh OS X speech recognition system.  If you set up speech recognition in your System 
Preferences, then you will able to create stacks where the buttons (or other objects with actions) can be activated with voice commands.  
Remember that it is necessary to configure a particular computer to a particular user, but once done for the computer in general, it will 
work with HyperStudio stacks on that computer with that user as well.
Like KeyMapper, this sets up the key assignments for many buttons, it is not used as the “Action” for the button that will respond to the 
spoken word or phrase, but rather this is often used with “About This Card” or “About This Stack”, and “arriving at card”, or “arriving 
at stack”.  The speech recognition function stays active for the defined keys until HyperStudio quits, or a different button or other object 
redefines that a particular word or phrase is assigned to a new button or object.

   

StarField: This is a purely “for fun” function that moves a bunch of stars on the card, as though the user was travelling through space 
with stars.  
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Testing functions: This assigns a “plus” or “minus” counter to any button or other object, or alternatively a “no testing function” 
(which does not increment a counter). It will also put up a window where the user can enter their name.  When the user leaves the stack 
to another stack, or quits HyperStudio, a text file is written to the same folder as the stack with the name “HS.Test.Results.txt” with a 
<Return> delimited file that can be read by spreadsheets and database software applications.

   

TextMover: This moves text from one text object to another.  It will also move the contents of the “Comments and Attributions” fields 
for objects on a card into a text object, which can be useful for creating “rolling credits” at the end of a stack, and in particular if you are 
exporting it to video. See the MBA (More Button Actions) function “RollCredits”.
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